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1. Build an Enclosure 

▪ Get six 9"construction rails (XE25L09) and two 20" rails (XE25L20). Lay out three of the 9” rails 
in a "U" shape, with the two side rails laying on top of the bottom rail (Fig1.1). Join the rails 
using two setscrews (SS25S075) and drop-in T-nuts (XE25T1). Repeat above steps to make 
another "U" shape. 

▪ Connect two ‘U’ shape together with 20" construction rails at top corners. Join the rails with 
two setscrews and drop-in T-nuts in one side and fasten with two right angle brackets 
(AB90H), drop-in T nuts, and 1/4-20 screws in the other side (Fig.1.2). 

▪ Cut one 9"x22" thick acrylic board (8505K758) and fix it at the bottom of the enclosure using 
¼-20 screws and drop-in T-nuts. Cut two 9"x10", two 10”x22" and one 9"x22" thin acrylic 
boards (8505K745). Attach one 9"x10" and one 10"x22" board on the back and right side of 
the enclosure, respectively, with ¼-20 screws and drop-in T-nuts (Fig1.3). 

▪ Cut ten 9" and four 22" strips of magnetic tape. Pair together and place adhesive of one of the 
two paired strips on left side and front rails. Remove adhesive on other strip of magnetic tape 
pairs. Carefully align 9"x10" and 10"x22" acrylic sheets with their respective sides. Press firmly 
to secure adhesive to edges of acrylic sheet. 

▪ Cut a rectangular hole (7"x7") on the 9"x22" board and cover it with metal mesh. Place the 
board on the top to cover the enclosure (Fig1.4). 
 

                                  

 

                  Fig. 1.1                     Fig.1.2                  Fig.1.3                   Fig.1.4 
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2. Components on the Enclosure Side Boards 

▪ Get an analog pressure regulator (FESTO, 557773). Screw one L-shape push-in-fit (5225K564) 
in the inlet hole, and another L-shape push-in-fit (5779K425) in the outlet hole. Screw a 
silencer (9836K21) at the exhaust hole (hole no. 3).   

▪ Get a manual pressure regulator (LR-M5-D-7-MICRO) and fit with two push-in fitting (QSM-
M5-6). 

▪ Fix the above two regulators on the back board of the enclosure. (Fig.2.1). 
▪ Get a custom breakout PCB board (BCM-NL-HCT001). Solder three solid state relays (CC1139-

ND), one HX711 amplifier (SparkFun, SEN-13879), one MCP4725 DAC (Adafruit, 935), one LED 
driver (SparkFun, SS25S075), one 6-pin 2x3 box header connector (JP1), one 16-pin 2x8 box 
header connector (JP2), one 9-pin (JP4), one 6-pin (JP6) and one 16-pin 2x8 straight header 
connectors (JP5), on the PCB board (Fig.2.2). 
 

           

                  Fig.2.1                                                                     Fig. 2.2 
 

▪ Fix three Arduino boards (Mouse, A000062), one custom lickometer PCB, one 9V battery 
case, one 3/2-way solenoid valve (FESTO, 196847) and custom breakout PCB on the enclosure 
right board (Fig.2.3). Assemble a SD card shield (https://www.adafruit.com/product/1141), 
connect DIO5 to CD via a jump wire, and insert the SD card shield into Arduino_Master board. 

 

                

      Fig. 2.3 

https://www.adafruit.com/product/1141
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3. Lickport Station  

▪ Cut two 18”, two 9”, and two 2” pieces of 1/32” plastic tubing (Tygon E-3603). 
▪ Remove plungers from two 30 mL syringes. Tape syringes together at top with regular tape. 

Attach female luers (45508-02) to syringes. Attach 18” tubing to luers. 
▪ Attach 9” tubing to top port of two Lee company solenoid valves (LHDA1233215H), and 18” 

tubing from 30 mL syringes to middle ports. Tie each of 2” pieces in knot and slide one end 
over the bottom ports (Fig.3.1) 

▪ Cut two 2” pieces of 18G stainless steel tubing with Dremel tool. Smooth at least one end for 
licking.  

▪ Slide steel tubing into the two holes of the custom lickport holder. These holes may need to 
be reamed out with a #51 drill bit. Place tubes securely with ~ 1/2” sticking out of front end. 
Glue if necessary.  

▪ Get two 10” wires (different color) and solder one end to steel tubing. Slide a piece of heat 
shrink over tubing and soldered wire. Heat with heat gun to shrink material and create tight 
fit. Crimp the other end of the wires to a female pin connector (Fig.3.2) 

▪ Slide free ends of 9” plastic tubing over steel tubing on the heat shrink side. 
 

        

Fig. 3.1 Fig.3.2 

  
  

▪ Get a 3D-printed switch holder and two mini toggle switches, one for left solenoid and one for 
right solenoid. Fix the switches to the holder (Fig.3.3). 

▪ Get five cables of 24”. Solder these 5 cables to the switches’ pin1, pin2 and pin3 accordingly as 
shown in the picture (Fig.3.4, Fig.3.5). 

▪ Label “Flush” on the front panel of the switch holder to indicate the direction in which the 
switch is toggled to Pin1. 
 

                         

             Fig. 3.3                                           Fig. 3.4                                           Fig. 3.5 
 



4 
 

4. Weighting Stage and Home-cage 

▪ Get 3D-printed parts WeightingStage_bottom and WeightingStage_top, a micro load cell 
(Phidgets, 100g), a piece of aluminum sheet (2.5”x1.25”x0.016”) and a flat ribbon cable of 20 
cm with one end having 6-pin (2x3) female connector (Fig.4.1). 

▪ Fix the load cell on the WeightingStage_bottom using two screws (M2.5x12mm) and nuts. Make 
sure the arrow on the load cell is downward. 

▪ Strip two ends of a wire. Tape one end of the striped wire on the aluminum sheet by aluminum 
tape. Route the other end of the wire out of the hole of WeightingStage_top and then out of the 
hole of WeightingStage_bottom. Glue the aluminum sheet on top of WeightingStage_top and 
let the side with the wire attached facing down. 

▪ Secure WeightingStage_top on the load cell using another two screws (M2.5x12 mm) and nuts 
(Fig.4.2). 

▪ According to the connector pinout in Table1, solder the four wires from load cell and one wire 
from the aluminum sheet to the open end of the ribbon cable (Fig. 4.3).   

    

                                    

  

Fig. 4.1                                          Fig. 4.2                                        Fig. 4.3 
 

                                                            Table 1. 6Pin (2x3) female connector Pinout 

 
 
                                  
 
 
 

 

 
 

▪ Align the custom 3D-printed headport and the weighting stage assembled above against one 
side of the home-cage. According to the positions of the headport, drill two holes (7 mm) and 
one opening (30mm x 30mm). The headport should be attached to the home-cage such that 
the lower edge of the home-cage opening is trimmed with the weighting stage and the lower 
edge of the headport opening is a bit higher than the weighting stage (Fig.4.4). 

▪ Drill a small opening (~15mm x 10mm) on the lower side of the home-cage to allow the ribbon 
cable connector (2x3 female connector) of the weighting stage go through.  

▪ Align the weighting stage on the floor of the home-cage, centered around the opening. Mark 
the mounting locations and drill four threaded holes (4-40) on the floor. Fix the weighting 
stage to the threaded holes using size 4-40 screws (Fig.4.5).   

Connector Pin# Weighting Stage Wire 

Pin 4 AL Sheet 

Pin 2 RED 

Pin 5  BLACK 

Pin 3 WHITE 

Pin 1 GREEN 
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Fig.4.4                                                                              Fig.4.5 
 

5. Headport 

5.1. Apply aluminum tape on the headport (Fig. 5.1): 
▪ Apply aluminum tape on the floor of the headport opening and route it to the side of 

the headport by another piece of aluminum tape. 
▪ Get a wire, strip two ends. Attach one end of the wire to the aluminum tape on the side 

of the headport and the other end of the wire will be soldered to the Headport ribbon 
cable. 
 

                     
                            Fig. 5.1                                                                     Fig.5.2 

5.2. Set up switches (Fig.5.4): 
▪ Get two snap action switches (D429-R1ML-G2) and four screws (M3x25mm) and nuts 

(Fig.5.3). 
▪ Bend the first 3 mm of the switch lever outward to form a 90-degree angle. 
▪ Fix the two switches on each side of the switch holder in the headport with the screws 

and nuts. Adjust the position to make sure the switches can be triggered only when the 
headbar (Fig.5.2) reaches the end of the headbar track of the headport. 

▪ Connect pin1 of the two switches by soldering a jump wire. Solder a wire to pin4 of 
each switch and a wire to pin1 of one switch. These wires are with the other end free 
and to be soldered to the Headport ribbon cable. 
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                   Fig.5.3                                                             Fig.5.4 
 

5.3. Set up motors (Fig.5.5, Fig.5.6): 
▪ Get one 50mm and one 30mm stroke motor (Actuonix, L12).  
▪ Get one 3D-printed motor holder and thread the holes with 6-32 and 8-32 tap. Fix the 

50mm motor at the tip of the 30mm motor in an orthogonal way using the 3D-printed 
holder with 6-32 x ¼” screws and 8-32 x ½” screw.  

▪ Fix the lickport holder at the tip of 50mm motor using one screw (M4x25mm) and 
three nuts. 

▪ Thread the two holes located at the lower right side of the headport floor using 6-32 
tap. Fix the motors on the headport floor using a bracket set which is came with the 
motor and 6-32 x 3/8” screws. Be sure to put a thin washer under the bracket to 
adjust the gap between the motor and the headport floor. 

▪ From each motor, take red, black and blue wires and put them together into a 1x3 pin 
connector housing to be connected to the Headport ribbon cable. 

                   

          Fig.5.5                                                             Fig.5.6 
 

     

5.4.  Set up head-fixation pistons (Fig.5.7): 
▪ Get two ¼’ OD Air Cylinder Pistons (McMaster, 6604K11) (with hex nuts). Grind the 

hex nuts outer shape to match the headport with Dremel. 
▪ Insert two shaped hex nuts in the headport, screw the pistons in the piston holes of 

the headport and fix them with two Panel Nuts (McMaster, 5601396540). 
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▪ Screw two Push-in-Fitting connectors (McMaster, 5779K246) in the air inlet holes of 
the pistons. 

    

                                                                    Fig.5.7 

5.5. Set up pole mechanism (Fig.5.8, Fig.5.9): 
▪ Get one Air Cylinder Pistons (McMaster, 6498K999). Insert the piston into the pole 

holder of the headport and screw one hex nut (10-32) on the rod of the piston until 
flush. 

▪ Get one 3D printed pole and one 30mm stroke motor (Actuonix, L12-30). Insert the 
pole into the hole at the tip of motor. Take red, black and blue wires from the motor 
and put them together into a 1x3 pin connector housing to be connected to the 
Headport ribbon cable. 

▪ Fix the motor at the end of the piston with 3D printed bracket. Screw two hex nuts 
(3/8”-24) at the end until flush. 

▪ Screw one Push-in-Fitting connectors (McMaster, 5779K246) in the air inlet holes of 
the pistons. 

                                      

           Fig.5.8                                                               Fig.5.9 
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5.6. Set up Piezo Buzzer (Fig.5.10) 
▪ Get a Piezo Buzzer (490-CPE-160) and a cable with one end free and one end pre-

crimped. Solder the free end of the cable to the Buzzer and have the other end ready 
to be connected to the headport ribbon cable.  Fix the buzzer on the Headport floor.  

 

                                 

Fig.5.10                                                         Fig.5.11 
 

5.7. Built the headport ribbon cable 
▪ Get a flat Ribbon cable of 20cm with one end having 16Pin (2x8) female connector 

and the other end free.  
▪ According to the connector pinout in Table2, solder and connect all the electric 

components located at the headport to the headport ribbon cable (Fig.5.11). 
 

Table2. 16Pin (2x8) female connector Pinout: 

 

 
 
 

Connector Pin# Headport Electric Components Wires 

Pin 1,3,5,7,16 NC 

Pin 9 Piezo Buzzer + (Red)  

Pin 11  Switch L (pin4) 

Pin 13 Switch R (pin 4) 

Pin 15 Motor LR/FB/Pole GND (Black), Switch Com(pin1), Piezo Buzzer- (Black) 

Pin 2  Motor LR/FB/Pole Power (+12v, Red) 

Pin 4  Motor LR Input (Blue) 

Pin 6 Motor FB Input (Blue) 

Pin 8  Motor Pole Input (Blue) 

Pin 10 Lickport Right 

Pin 12 Lickport Left 

Pin 14  Headport AL Tape 
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6. Pneumatics 

▪ Attach a push-in-fit (QSM-M7-6-I) in the exhaust hole of the 3/2-way solenoid valve (hole no. 
3). Connect it to a flow control valve (GRLA-1/8-QS-6-RS-D) using 6-mm tubing (Freelin-Wade, 
1E-158-08) 

▪ Get another flow control valve, attach a female push-in-fit (QSF-1/8-6-B) on the threaded port. 
▪ Connect all the pneumatic parts using 6-mm tubing according to Fig.6.1. 
▪ Attach a power/control cable (SIM-M12-5GD-2,5-PU) to the analog pressure regulator  

 
 
 

 
 

Fig. 6.1 
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7. Circuit and Assembly 

 

 

 

Fig.7.1 
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▪ Connect the electric circuit according to the above diagram Fig.7.1. The components in 
the circuit can be located at Fig.2.1, Fig.2.2, Fig.2.3 and Fig.3.4 accordingly. Fig.7.2 shows 
the completed circuit connection. 

          

                                            
                                           Fig. 7.2 
 

▪ Mount the Lee solenoids (Fig.7.3), reward switches (Fig.7.4) and Arduino switch (Fig.7.5) 
on the enclosure frame (Fig.7.6).  

 

                          
 Fig.7.3                  Fig.7.4                  Fig.7.5                       Fig.7.6 
 

▪ Table3 shows input/output wires/pipe for the Automated Home-cage System after 
assembly. 

 
Table3. Home-cage I/O  

 Item Name Function 

 12v AC/DC wall mount Adapter Provide 12v power for Arduinos, motors 
and Lee solenoids  

Input 24v AC/DC wall mount Adapter Provide 24v power for 3/2-way solenoid 
valve and analog pressure regulator 

 USB 2.0 to Micro B Cable Connect Arduino_Master to PC 

 Plastic tube Provide Air supply (4-bar) to Home-cage 

Output BNC Cable Send voltages (0-5 V) to control Laser 
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8. Prepare Computer 

The following software should be installed to the computer for testing and operating the Automated 
Home-cage System: 
▪ Download the latest version of MATLAB from https://www.mathworks.com. After installed it, 

do the following steps to adjust Java Heap Memory to be half of the full Java Heap Size: 
o Start MATLAB. 
o On the Home tab, in the Environment section, click Preferences. Select MATLAB 

> General > Java Heap Memory.  
o Select a Java heap size value using the slider or spin box. 
o Click OK. 
o Restart MATLAB. 

▪ Download the Serial/TCP Terminal (realterm.exe) from 
https://sourceforge.net/projects/realterm/files/Realterm/ 

▪ Download the latest version of the Arduino IDE from https://www.arduino.cc. After installed it, 
with the Arduino plugged into a USB port, start up the IDE and make sure that the correct board 
name/version and COM port appears under the Tools menu. 

• The COM port can be seen in the Windows Device Manager. 
• A support package for Arduino DUE needs to be downloaded via the IDE:  

o Click the menu item Tools → Board → Boards Manager. 
o Search ‘due’ and find Arduino Due package. 
o Click on the Install button that appears. 

• Copy all the files in the folder “\Arduino programs\Tactile delayed response task\Library\” 
to the PC folder:\Program Files (x86)\Arduino\libraries\”.  

• To upload an Arduino program to Arduino board via the IDE, do the following steps: 
o Connect a USB cable from PC to the Native USB of the Arduino board. 
o Click the menu item File → Open, select the program. 
o Click the menu item Tools → Board, select the correct Arduino port 
o Click the menu item Tools → Port, select the correct COM port. 
o Click the button Upload. 

9. Testing Procedure 

9.1. SD Card 
▪ Insert a battery (CR1220) to SD card shield.  
▪ Copy all the files in the folder “\Test\final config files\” to a SD card. 
▪ Insert the SD card to SD card shield. 

9.2. On-board Date/Time Correction 
▪ Upload “\Test\correctTime\correctTime.ino” to Arduino_Master board. 
▪ After upload is done, run Realterm.exe on PC to receive Date/Time info from 

Arduino_Master board. The current Date/Time should be read on the Realterm display 
window. 

9.3. Weight Calibration    
▪ Do not reset Arduino from last step. 
▪ Upload “\Test\Weight_Calibration\Weight_Calibration.ino” to Arduino_ Master board 

and run Realterm.exe on PC to receive weight info. 

https://www.mathworks.com/
https://sourceforge.net/projects/realterm/files/Realterm/
https://www.arduino.cc/
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▪ Put an object with known weight on the weighting stage. The reading on the Realterm 
display window should be roughly matched to the weight. Adjust the calibration_factor 
if the reading is not matched.  

▪ Set the correct calibration_factor in the program “\Arduino programs\XXX task\ 
Arduino_ Master\Arduino_Master.ino”. 

9.4. Upload Arduino program 
     In the folder “\Arduino programs\Tactile delayed response task\”: 

▪ Upload “\Arduino_Wave\Arduino_Wave.ino” to the Arduino_Wave board. 
▪ Upload “\ Arduino_Task\Arduino_Task.ino” to the Arduino_Task board. 
▪ Upload “\ Arduino_ Master\Arduino_Master.ino’”to the Arduino_ Master board. 

9.5. Air/Power supply 
▪ Supply the plastic tube of the Automated Home-cage System with the compressed air 4 

bars. 
▪ Adjust the manual pressure regulator (Fig.2.1) to 2 bars and check if there is air leaking. 
▪ Power up the Automated Home-cage System with 12V and 24V adapters.  
▪ Connect the USB cable from the Native USB Port of the Arduino_Master board to PC. 

9.6. Test motors and adjust motor position 
▪ Run “\Matlab GUI\homecage_gui.m program in MATLAB and the HomeCage GUI shows 

up as Fig.9.1. 
▪ In HomeCage GUI, chose a cage and open the corresponding COM.  
▪ In Control Panel of HomeCage GUI, chose the above cage, input a value (0-255) and click 

“Move & Set” to see if the corresponding motor moves by the expected distance. 
▪ Move the LR motor to the initial position (70 by default), loose the bracket which holds 

the LR motor, adjust the location of the LR motor so that the lickport is roughly at the 
center of the head port.  

▪ Move the FB motor to the final position (30 by default), loose the bracket which holds 
the FB motor, adjust the location of the FB motor so that the tip of the lickport is about 
14 mm from the wall of the headport. And then move the FB motor to the position 130, 
the tip of the lickport should just touch the wall.  

9.7. Test Tare function 
▪ Make sure nothing is on the weighting stage and click Tare button in HomeCage GUI. 
▪ Click Read button, the text field of Weight should show a value close to zero.  
▪ Put an object with known weight W (g) on the weighting stage and click Read button 

again, the text field of Weight should show a value close to W (g). 

9.8. Test the reward solenoid valves 
▪ Fill the water reservoir with water. 
▪ Toggle the reward switch to the “Flush” side to turn on the solenoid valve. The water 

should flow out of the water reservoir, fill up the whole tubing and then flow out of the 
lickport. 

▪ Toggle the reward switch to the other side. When turn on the Arduino switch, A drop of 
water should come out of both lickport tubes. 

▪ Click Set&Reward button in Homecage GUI, and a drop of water should also come out 
of both lickport tubes. 
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Fig.9.1 
9.9. Test the lickometer board (Fig.9.2) 

▪ The two Trimmer Resistors (R10/R21) on the lickometer board should be turned to the 
maximum value. 

▪ The two capacitors on the lickometer board should be 0.47uf. 
▪ Measure the voltage between the left and right pins in J3/J5 of the lickometer board, 

the resting voltage is around 0.3v, and the voltage goes up to around 3.8v when you 
connect the left/right lickport with the aluminum tape on the headport by your hand. 

▪ Connect both J3 and J5 to an oscilloscope (left pin to probe and right pin to ground), 
touch the lickport by your hand, and check if there is any crosstalk between the two 
lickport tubes. Adjust R10/R21 and change the capacitors if necessary. 
 

                                          

                                              Fig.9.2                                                                                   



15 
 

 
9.10. Test the trial sequence 

9.10.1. Trial sequence 
▪ With the SD card having the final config files, turn on the Arduino switch and 

trigger the two switches in the headport by the headbar. The trial runs with the 
following sequence:   

1) Pistons for head-fixation comes down. 
2) Motor for pole moves either forward or backward depending on the 

trial type. 
3) Masking LED turns on and flashes. 
4) Piston for pole comes down and stays down for about 1.3s. 
5) Piston for pole comes up. 
6) Piezo Buzzer makes a go cue sound. 
7) Masking LED off. 

Trials repeat the above sequence (1-7) until the head fixation is timeout (~60s), 
and then the Pistons for head-fixation comes up. Each trial takes about 6s. 
 

9.10.2. Checking List 
     During a trial, check the functionality of the following items: 

▪ Pistons for head-fixation:  coming down and retracting smoothly, fixation 
(staying down) for ~60s. 

▪ Piston for pole: coming down and retracting smoothly. Adjust the flow control 
valves if necessary. 

▪ Motor for pole: moving forward and backward smoothly. 
▪ Masking LED: flashing during the whole trial (~6 sec). 
▪ Lickports: the left and right lickports can be detected separately and correctly. 

Depending on the trial type, a drop of water should come out of the left/right 
lickport if connecting the corresponding lickport to the aluminum tape on 
headport/weighting stage by your hands right after the go cue sound is heard in 
each trial. 

▪ Weighting stage: during head-fixation, press or lift the weighting stage lightly, 
the pistons for head-fixation should be released. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


